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Intro  

The World Wide Web is immense and chaotic, and Tramline's TourMaker is a tool that 
provides control and focus for many applications.  

With it, you can create thematic presentations called "Web Tours" from 
multiple Web pages and your own custom text. With tours on your site, you 
can take users out onto the Web to explore its resources and then bring them 
back safely to your site when done. 

At its simplest, each Tour is composed of sites and narration integrated 
together into a sequence that the user can access using controls from the "Tour 
Control Panel." Tours are launched from hypertext links by a simple mouse 
click. This opens a "Tour Window" containing the script for the tour and the 
controls to take it. The user moves through the tour as they desire, exploring or 
lingering, but never getting lost. They can always get back to the tour or your 
site with a single mouse click. 

TourMaker is both a browser and an authoring system. With it, you select the 
sites for a tour and enter the text for the tour narrations. As you do this, you 
gradually create each tour, so you view the tour as a work in progress until you 
have selected the last site and entered the last narration. At that point, you save 
your work and the tour is finished. It will run just as you saw it in TourMaker. 

Requirements 

Using TourMaker requires a minimum of Windows '95 and Explorer 4.0. 
Tours, however, will run on most recent versions of Explorer, Navigator and 
AOL on both Mac and Windows platforms.  

Installation 

Before you can use it, you have to install it on your system. Installation is a 
simple "click and follow directions" process. We recommend following 
the default settings regarding where you save TourMaker since we refer to 
these settings throughout this document. You shouldn't experience problems 
and we don't think you will. However, if you do, let us know immediately at 
info@tramline.com. We will get back to you as quickly as we can.  
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Getting Started  

 First, a little terminology...  

We generally call our technology "virtual Web tours" or tours for short, with the 
exception of our "Virtual Field Trips" site, where we call them "field trips." Both 
mean the same thing. 

The tour window contains several components. Sites are viewed through the "site 
frame." The text for each stop (the "narration") appears in the "narration frame." 
Controls for navigating through the tour are in the "control panel." Note: The names 
for the control panel buttons and their functions are described in the Help page that is 
opened with the "?" button on the control panel.  

Opening TourMaker  

TourMaker is opened from the Start menu or from a shortcut like any Windows 
program.  

Registration Number  

Once you have installed and opened TourMaker, you are given a choice as to whether 
you will register your copy (and therefore unlock its full functionality) or just try the 
program in its trial mode. If you do not have one, a registration number can be 
purchased through our Web site http://www.tramline.com/store.htm. Once you enter 
your registration number in TourMaker, you will be able to save tours and the trial 
option will disappear.  

Note: Save the registration number in a safe place because it will be needed if 
reinstalling the program ever becomes necessary. 

The TourMaker Wizard  

Once you are beyond the initial registration/trial dialog box, you will see the 
TourMaker window that is very similar to the Tour Window. You will also see the 
TourMaker "Wizard," a dialogue box that allows you to choose whether to "Create a 
new tour" or "Edit an existing one." In this case, we'll try editing an existing one first 
and then discuss what you would do to create a new tour. 
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Tutorial: Edit an Existing Tour  

1. In the TourMaker Wizard, click on "Edit an existing tour" and then the "Next" button. 
2. Highlight the "Sample" folder under "My Tours" and click on the "OK" button.  

Note: You select the folder, not a file. If you look for a file to select, you'll never 
find one. 

 

3. You've now opened a sample tour for editing. Note that the interface looks just like the 
Tour Window, except for the menu and buttons at the top.  



TourMaker Reference Manual, © 2002 Tramline. All rights reserved. 
No part of this document may be reproduced without written permission from Tramline. 

www.tramline.com 

4 

 

4. Click the forward arrow to go to the first stop, Tramline's home page. Explore the 
TourMaker buttons by holding your pointer over each to see the pop-up description. 
You probably shouldn't click on them just yet. You might delete a stop or do 
something else you don't really want to do at this point. 

5. Now explore the menu. In particular, note each of the options in the Edit menu. These 
control the most basic features of the tours you'll create, including the selection of 
sites in the Site Frame and the addition of text in the Narration Frame. 

 

6. Now let's really get started. Click on the "+" button to insert a stop. (Note: you could 
also have selected "Insert" from the Stop menu.) 

7. Select "Site Frame" in the Edit menu to open the "Site Editor" window in which you 
will select sites for the tour. Run your pointer across the window's buttons to see their 
names. Note that in the Address Bar is a "local" address for the page you are viewing 
("Thank you ..."), i.e., it's on your hard drive in the TourMaker file. You can replace 
this with any other HTML page you have on your hard drive by clicking on the "Select 
Local File" button and then locating the file using the Select Local File dialogue box. 
Before we do that, however, let's find and add an existing Web page to this tour, since 
that's what this is all about. 
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8. In the Site Editor, click on the Search button. This brings up a page of links to search 
engines. Click on the one of your choice. The search engine page will appear in the 
window.  

9. Now, from this point you can explore the Internet to your heart's content. Rather than 
do that now, click the checkmark button (Use this Site). Note that the TourMaker 
Window has moved to the top of the desktop. You have just added the search engine 
site as a stop on the tour. Now, you have to add the narration. 

10. Select "Narration Frame" from the Edit panel to open the "Narration Editor." It has 
two areas for entering information: Stop Title and Stop Text. The title should 
generally be a short descriptive one. The text can be longer, and you can format it 
using the various buttons below the text window (more about that under Narration 
Editor, below).  
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Enter whatever you wish here and click the Apply button--your entry should now 
appear in the narration window. OK, you've just added one stop with narration. 
Multiply that ten or so times and you have a tour. At this point, you now know the 
basics on creating a tour. We'd recommend you continue to play around with the 
sample tour for a while, though, and add, delete, or change it as you wish. When 
you're done, you can save your changes or just Quit the program to leave the Sample 
Tour as is. When done, you've experienced a good introduction to developing a tour. 
However, there are a few more things we'd like to point out. 

Key Features and Tips  

Trial Use  

When you use TourMaker prior to registering, you can test all its 
functions, but you will not be able to save a tour. In the process, you 
will name and create a tour folder for your trial tour that will be 
placed in the MyTours folder. Once you register and create tours, the 
trial folder will still be in the MyTours folder unless you delete it or 
use it to create and save a tour. 

MyTours Folder  

TourMaker's recommended default location for tours it creates: 
C:\Program_Files\Tramline\TourMaker\MyTours 
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Tour Folder  

Tours are saved in folders containing all the associated files for the tour. When editing 
a tour in TourMaker, it is important to remember to select the tour folder, not a file, as 
TourMaker will only open a folder.  

HTML Editor  

You can select a program as your default HTML editor by selecting "Options" in the 
"View" menu. Note that Word and other word processors generally have HTML 
features and may be used. See also: "Custom Pages/Local Files." 

The Site Editor (Edit menu: Site Frame)  

The Site Editor allows you to search the Internet or your hard drive for the sites or 
local files you'll use as stops in your tour. In addition to basic browser features, it has 
some features designed specifically for tour creation. In particular, the bookmark 
feature allows you to annotate your bookmarks. You bookmark pages by clicking on 
the "Remember" button. When you do, the address will be stored in the Bookmarks 
window. You can write notes about these bookmarks and store them with the 
bookmark by selecting the Edit Notes button.  

In addition to searching the Web, the Site Editor allows you to select local files by 
clicking on the "Select Local File" button. If you haven't already created the local file, 
you can open your HTML editor by clicking on the Launch HTML Editor button. 
(Note: for this to function, you must first tell TourMaker what your HTML editor is by 
selecting Options in the View menu. Then browse until you find the program you want 
to use and select it.)  

Narration Editor (Edit menu: Narration Frame)  

The buttons allow you to format the text (bold, italic, etc.). You do so by highlighting 
the text and then clicking the button. If you want to add a link to the text, highlight the 
appropriate word, then click on the "Add Hyperlink" button. A dialogue box asking 
you to type a URL appears. Enter it and click OK. Your narration will now contain a 
link that when clicked will open another URL in the Site Window. 

Tour Properties  

There are many useful features to this dialogue box. The first is that you name the tour 
in the "General" section as it will appear on the automatic opening Help page. You can 
also set the caching time for each stop (see below). Perhaps the most important feature 
is that you will set the location of the web page(s) from which your tour will be 
launched. Note: the "Layout" and "Logo" options are not available in the Educational 
Version. 
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Caching  

Tours can be cached, i.e., automatically downloaded to a user's computer. Caching of 
stops occurs at predetermined intervals that the tour author can adjust in the Tour 
Properties dialogue box of TourMaker. The default setting is 30 seconds. In other 
words, each stop will be downloaded for 30 seconds before the next stop is 
downloaded. Since each stop has a different cache time, some stops will cache at one 
setting while others won't. Note that caching is turned off in TourMaker's authoring 
mode. It will only work in the actual tour. 

 

Frames  

Every once in a while, we come across a site that is frame intolerant. That is, it will 
not allow itself to be viewed in a frame. If you put such a site in a tour, the narration 
and control panel windows would disappear the moment the site loaded. There are 
very few such sites on the Web, but they do exist. As a precaution, we’ve developed 
an automatic test that allows us to determine if a site is frame tolerant. When you click 
on the checkmark button (Use This Site) in the Site Editor, it automatically verifies 
that the site is frame tolerant. If it isn't, it will tell you so and you will have to find 
another site.  
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Tour Structure  

Tours work best that are focused around a theme, topic, or story. There are no hard 
rules, but we try to keep ours to no more than 15 to 20 stops. The first stop is an 
orientation page with the title of the tour and some basic guidance for the user. It is 
automatically generated by TourMaker, but you can replace it with something else if 
you'd like. When possible, we also like to include an introductory page containing a 
brief overview on tour objectives and content, as well as any other relevant 
information (see Custom Pages, below). For example, if Shockwave is needed for 
some of the stops, here is a good place to mention it.  

Narration  

The narration frame is small, so the narration for any stop should be economical and 
efficient. Users will not want to do extensive scrolling to read it. That said, the 
narration should always identify the site being visited and the objectives of the visit 
(for legal reasons, Web etiquette, and just plain clarity), along with providing 
suggestions or instructions on what to do there. If a large amount of text is needed 
(such as background or reference information), you should consider making it into a 
custom page (see below). This allows you to integrate more content into the tour than 
the narration window can reasonably accommodate.  

Note: The narration frame automatically contains a hyperlink that will open the site 
being viewed in a third frameless window. This allows viewers to see the site without 
having it hemmed in by our frames. When a user moves forward or backward on the 
tour, this third window is automatically closed. 

Custom Pages/Local Files  

These are simple HTML documents stored on your server and downloaded to the 
user’s drive just like the web sites they'll visit. They are viewed through the Site 
Window on a tour. For example, TourMaker automatically generates a simple custom 
page for the first stop of each tour (mentioned above). Adding custom pages is an 
excellent way to provide context and content to a tour. Possible uses include providing 
background information on a subject, ancillary information to be printed and viewed 
while taking the tour, lists of additional links (see below), etc.  

Local files can be placed anywhere on the tour either as a stop or as a page brought 
into the site window by a narration link, and you can do anything on them that you see 
on any Web page. The only catch is that you'll have to create them yourself using an 
HTML editor and then save them as local files on your system. You can create a local 
file anywhere on your hard drive, but note that it probably shouldn't be in the actual 
tour folder you're working on, because TourMaker copies the file to that folder and 
will tell you it can't if the file is already there.  
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Since Word and other word processors generally contain an HTML editor, you 
probably won't have a problem creating at least simple HTML pages, but you may 
need experience to achieve more ambitious results. That said, it is generally a good 
idea to keep both text and graphics simple for such pages.  

Lists of Links  

Since relatively brief tours are best, yet there are so many possible Web resources to 
see, it is often useful to develop a list of additional resources as a custom page and to 
include it as a stop (often the last) or stops in a tour. The tour format offers a 
significant benefit on such lists in that the user can explore them without getting lost: 
whenever they wish, they can return to the tour by clicking on the "Return To Tour" 
button on the control panel. 

Narration Links  

You can put a link into the narration that opens a second web page in the site window. 
This means, for example, you can take users to one URL at a stop and then instruct 
them to click on a link to see another URL or even a custom page. Technically, you 
can add as many links as you wish in the narration. However, because of the window's 
size and the fact that the narration at a stop cannot change even if the site does, you are 
pretty much limited to one or two additional links. In most cases, it is better to simply 
turn an additional link into another stop having its own narration.  

 

To create a link in the narration editor, highlight the link and click on the "Add 
Hyperlink" button. A TourMaker Enter URL dialog box (below) appears in which you 
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can enter your link. You then click on "OK" and a link appears in the narration frame 
that will open a new page in the site window. 

 

  

Tutorial: Creating A New Tour  

And now it's time to create your own tours…. 

1. Open TourMaker. 
2. Select "Create a New Tour" and click Next in the TourMaker Wizard. 
3. Name the tour and the folder in which it will go. The name (or tour title) is what will 

appear on the tour title page (as in My Web Tour) and in the tour itinerary. It can be a 
phrase with or without punctuation. The folder name should be a "folder length" 
abbreviated version of the tour title that you can remember and recognize. Click Next. 

4. Select the "My Tours" folder and click Finish to save your tour folder there. 
5. You're in the tour at the tour title/orientation page. Note that this is a custom page 

automatically generated by TourMaker and stored as a local file.  
6. Click the forward arrow to move to the first stop. 
7. Open the Site Editor and select a site as you did in the Edit Tour Tutorial (in Getting 

Started).  
8. Open the Narration Editor and add the stop narration. Be sure to include a stop title. 

Click on Apply. 
9. Add stops and build your tour. It's that easy. 
10. SAVE the tour when you are done.  
11. Reopen it and play it. Make sure it's the way you want it. When it is, post it to your 

web site following the directions in the next section. 

 

Posting Your Tour to the Web  

When you have completed and saved your tour, you will need to upload it to the Web in order 
for others to enjoy. But first you will have to:  

• Create a web page that includes a link to your tour and its files. 
• Upload your web page and tour folder and files to your web site. 
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Before we begin, let’s take a simple look at the tour process and then we’ll tell you how to do 
it. A user takes a tour by clicking a hyperlink on your web page. The tour launches (starts). 
When they are done with the tour, they click the Exit button on the tour control panel, the tour 
ends, and the user is returned to your web page. 

  

Creating a Launch Page 

Using whatever tools you normally use to create web pages, create a web page (also referred 
to as a launch page because it is from this page that users will be able to launch your tour) that 
will have a link to your tour. You may want to have both a text link and an icon linking to 
your tour. Here's a sample page (below) that we created for our Big Apple Tour. We designed 
our page to include the tour name "Big Apple Tour", a descriptive sentence about the tour, 
and some other information relevant to our particular web site, however, the purpose of this 
page was to link to our tour, so there is both an icon link and a text link to the Big Apple 
Tour. 
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If you looked at the source code of the web page above, here is the HTML code you would 
see for the tour links. We'll go into more detail about this in the next sections but wanted to 
give you a sneak preview.  

Assuming that the tour folder is called "newyork", which is stored inside the "webtours" 
folder at "www.tramline.com/tm/, the html code for the Big Apple Tour icon link will be:  
<a href="http://www.tramline.com/tm/webtours/newyork/_tourlaunch1.htm"><img 
src="tour.gif" width="40" height="40" alt="New York City" border="0"></a>  

and here is the html code for the text link which reads "Click here to take the Big Apple 
Tour." 
<a href="http://www.tramline.com/tm/webtours/newyork/_tourlaunch1.htm"><big>Click 
here to take the Big Apple Tour</big></a> 

Your code will be similar but you will instead be using the URL to YOUR tour on YOUR 
web site.  

The Tourlaunch File 

The link to your tour on your launch page is a hyperlink to a specific file called 
_tourlaunch1.htm. (In the html code example provided above, you can see this filename in the 
last part of the URL.) The tourlaunch file serves two purposes:  

1. It launches the tour, and  
2. it remembers the URL of your launching web page so that when the user clicks the 

Exit button and leaves the tour, they are returned to your web page. 

This file is automatically generated (and placed in your tour folder) by TourMaker when you 
enter one or more URLs in the Launching tab of TourMaker’s Tour Properties (If this isn’t 
clear, go into TourMaker and click the Tour Properties button  to see the dialog box 
below).  
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Enter the URL of the web page from where users will play your tour (this would be the URL 
of wherever you'll put the launch page you’ve created). Then click Add (see picture below). 
After you click Add, the URL will be visible in the Tour will be launched from: box on the 
right. 
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It’s possible to launch a tour from multiple locations but for each unique location you will 
need a slightly different version of the tourlaunch file. The first tourlaunch file is named 
'_tourlaunch1.htm', the second one '_tourlaunch2.htm' etc. Each successive tourlaunch file 
will be automatically created when you enter more than one URL in the Tour Properties 
Launch option in TourMaker (see picture below). 

 

To launch the tour from the first URL, you need to create a hyperlink on your launch page to 
'_tourlaunch1.htm'. Similarly, to launch the same tour from a different web site or page 
(second URL), you will need to create a launch page at that location with a hyperlink to 
'_tourlaunch2.htm'. 

To see which tourlaunch file corresponds to which launching point, take a look at the file in 
your tour folder called link.txt. 
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This file is modified any time you change the URL list in the Tour Properties of TourMaker. 
In the example below, there are three different locations from which we want to launch our 
tour. 

 

If I want users to access the Big Apple Tour (which is stored at 
www.tramline.com/tm/webtours/newyork) from www.tramline.com/newyork.htm (my first 
launch page), then my link will look like this:  
<a href="http://www.tramline.com/tm/webtours/newyork/_tourlaunch1.htm"><big>Click 
here to take the Big Apple Tour</big></a> 

Additionally, if I want users to access the Big Apple Tour from 
www.virtualblackboard.com/webtours.htm (my hypothetical second launch page), then my 
link could look like this:  
<a href="http://www.tramline.com/tm/webtours/newyork/_tourlaunch2.htm"><big>Click 
here to take the Big Apple Tour</big></a> 
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Note that in both cases, the hyperlink points to the URL of the appropriate "_tourlaunch" file, 
where "_tourlaunch1.htm" will return the user to the first launch page which is located at the 
tramline.com site, while "_tourlaunch2.htm" will return the user to the second launch page 
which is located at the field-guides.com site. 

The Link to your Tour 

The link to your tour is like any other link in that it consists of the URL to the appropriate 
tourlaunch file(see example below). 

Typical link: http://www.yourdomain.com/tourfolder/_tourlaunch1.htm 

yourdomain.com will be replaced with www.something.com or www.something.edu 
(whatever your domain name is) In our example above, the domain name is tramline.com 

tourfolder will be the name you gave your tour folder. You should use the same name on 
your web site that you used on your hard drive. In our example above, the tour folder is 
several levels deep. The tour folder called newyork is stored in a folder called webtours 
which is in a folder called tm. This is done for site organization purposes. 
tm/webtours/newyork/ 

_tourlaunch1.htm is the name of the file that actually launches your tour. In our example 
above, the tourlaunch is called _tourlaunch1.htm but if you play your tour from more than 
one location, you will have subsequent tourlaunch files such as _tourlaunch2.htm and 
_tourlaunch3.htm. 

So you can see that if you put it all together you have: 

http://www.tramline.com/tm/webtours/newyork/_tourlaunch1.htm 

Note: Most current word processors have the ability to create HTML pages 
and to put hyperlinks in them. For example, in Microsoft Word you could create 
a launch page with the text you want (and--within limits--graphics), and put 
your tourlaunch link in it by using the "Hyperlink" option from the "Insert" 
menu. This will bring up a Hyperlink dialog box in which you will have to 
enter the tourlaunch link and click OK. You then select the "Save as HTML" 
option under the "File" menu and you have created an HTML launch page you can 
use. Different word processors operate differently of course, so you will have 
to consult the user manual for your particular program for specific instructions. 
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Uploading Your Tour to the Web 

Uploading your tour to a web site isn’t any different than uploading any other web page. You 
just need to make sure that all of the tour files in your tour folder on your hard drive are 
placed into a tour folder of the same name on your web site. 

If you have a tour folder on your hard drive called ‘tornado’ then you’ll want to create a tour 
folder on your web site called ‘tornado’. The ‘tornado’ folder on your hard drive has all of the 
tour files necessary for your tour to play so you have make sure to copy all of these files into 
the ‘tornado’ folder on your web site. 

Once you have your tour folder and files uploaded, you’ll want to upload your web launch 
page so people can take your tour.  

1. FTP to your web site. (Note that some FTP programs and servers are case sensitive 
therefore as a rule of thumb, name all of your files in lowercase.) 

2. Copy your tour launch page and any associated graphics to your web site. 
3. Create a tour folder on your web site and give it the same name as whatever you called 

your tour folder on your hard drive when you created your tour. 
4. Navigate to your tour folder on your hard drive and your tour folder on your web site. 
5. Copy the tour files from the tour folder on your hard drive to the tour folder on your 

web site. 
6. Go to your web site and make sure your tour works. 
7. Exit your ftp program. 
8. Announce your tour! 
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Running Tours from Your Hard Drive  

Besides running your tours from a Web site, you can also run them off the hard drive on your 
computer. TourMaker saves all the tour files needed in the folder for each tour you create. 
You simply need to open the right one and the tour will run. There are various reasons this is 
useful, but in a classroom situation in particular, this means students can create tours and 
present them to class without having to post them to a central school web site.  

There's more than one way to run tours off a hard drive, but we recommend using your 
browser to open the right tour file. First you need to know where the tour was saved. 
TourMaker's default location for tours is the MyTours folder inside the TourMaker folder that 
is inside the Tramline folder. If you didn't change this and save the tour somewhere else, you 
should find it there. Once you know where the tour is, here's how you open it: 

In Explorer:  

1. Select Open from the File menu. 
2. Choose Browse from the dialog box and then locate the folder for the tour you wish to 

open. Once you've found the right folder, select the file titled "framever" and click 
on Open.  

3. The address will appear in the Open dialog box. Click on OK and the tour should open 
immediately in Explorer. 

In Netscape:  

1. Select Open File or Open Page (depending on your version) from the File menu. 
2. Locate the tour folder using the Open dialog box. Highlight the framever file and 

click Open. The tour should open in Netscape immediately. 

  

If you need special assistance, send an email to info@tramline.com. 


